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Creating Calendar Integrations

See the following sections:

• About Calendar Integrations, page 35-1

• Creating a Calendar Integration with Exchange 2007, page 35-1

• Creating a Calendar Integration with Exchange 2003, page 35-10

• Creating a Calendar Integration with Cisco Unified MeetingPlace, page 35-18

• Creating a Calendar Integration with Cisco Unified MeetingPlace Express, page 35-25

About Calendar Integrations
When integrated with supported calendar applications (Exchange 2007, Exchange 2003, Cisco Unified 
MeetingPlace, or Cisco Unified MeetingPlace Express), Cisco Unity Connection enables users to do the 
following by phone:

• Hear a list of upcoming meetings (Outlook meetings only).

• Join a meeting that is in progress (MeetingPlace and MeetingPlace Express meetings only).

• Hear a list of the participants for a meeting.

• Send a message to the meeting organizer.

• Send a message to the meeting participants.

• Accept or decline meeting invitations (Outlook meetings only).

• Set up immediate meetings (MeetingPlace and MeetingPlace Express meetings only).

• Cancel a meeting (meeting organizers only).

When integrated with Exchange 2007 or Exchange 2003, Connection also enables user to import 
Exchange contacts by using the Cisco Unity Assistant web tool. The contact information can then be 
used in rules that users create in the Cisco Unity Personal Call Transfer Rules web tool and when users 
place outgoing calls by using voice commands.

Creating a Calendar Integration with Exchange 2007
If you have Exchange 2007 installed, you can integrate Cisco Unity Connection with Exchange 2007 so 
that users can do the following:

• Review upcoming meetings by phone.
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• Import Exchange contacts. The contact information can be used in rules that users create in the 
Personal Call Transfer Rules web tool and when users place outgoing calls by using voice 
commands.

Task List for Creating a Calendar Integration with Exchange 2007
1. Review the system requirements to confirm that all requirements for Exchange 2007 and the 

Cisco Unity Connection server have been met. See the “Requirements for the Exchange 2007 
Calendar Integration” section on page 35-2.

2. Configure Exchange 2007. See the “Configuring Exchange 2007 for the Calendar Integration” 
section on page 35-3.

3. Configure Connection. See the “Configuring Cisco Unity Connection for the Exchange 2007 
Calendar Integration” section on page 35-5.

4. (When enabling personal call transfer rules only) Verify that the users or templates are assigned to 
a class of service that enables them to use the personal call transfer rules feature.

5. Configure the Connection users. See the “Configuring Users for the Exchange 2007 Calendar 
Integration” section on page 35-6.

6. Test the calendar integration. See the “Testing the Exchange 2007 Calendar Integration” section on 
page 35-7.

7. To teach users how to use the Connection calendar, refer them to the following:

• For listing, joining, and scheduling meetings, see the “Cisco Unity Connection Phone Menus and 
Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone Interface 
(Release 7.x).

• For importing Exchange contacts, see the “Managing Your Personal Contacts” chapter of the User 
Guide for the Cisco Unity Connection Assistant Web Tool (Release 7.x).

• For using personal call transfer rules, see the User Guide for the Cisco Unity Connection Personal 
Call Transfer Rules Web Tool (Release 7.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/user/guide/pctr/7xcucugpctrx.ht
ml.

Note You can change the Cisco Unity Connection configuration and the user configuration after the calendar 
integration is created. See the “Changing the Cisco Unity Connection Configuration for the Exchange 
2007 Calendar Integration” section on page 35-8 and the “Changing the User Configuration for the 
Exchange 2007 Calendar Integration” section on page 35-8.

Requirements for the Exchange 2007 Calendar Integration
Revised May 2009
The calendar integration with Exchange 2007 has the following requirements:

• Exchange 2007 as described in the “Requirements for Accessing Calendar Information for 
Meetings” section of System Requirements for Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html
.
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• Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection 
Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/installation/guide/7xcucigx.html
.

Configuring Exchange 2007 for the Calendar Integration
Do the applicable procedure:

• If you are not using SSL for access to the Exchange 2007 server, do the “To Configure Basic Access 
to Exchange 2007 for the Calendar Integration (Without SSL)” procedure on page 35-3.

• If you are using SSL for secure access to the Exchange 2007 server, do the “To Configure Secure 
Access to Exchange 2007 for the Calendar Integration (With SSL)” procedure on page 35-4.

To Configure Basic Access to Exchange 2007 for the Calendar Integration (Without SSL)

Step 1 On the Exchange server, open the Exchange Management Console.

Step 2 Go to Microsoft Exchange > Recipient Configuration > Mailbox.

Step 3 Right-click a mailbox that you want to enable for the calendar integration and click Properties.

Step 4 In the Properties dialog box, click the Mailbox Features tab.

Step 5 Click Outlook Web Access and click the Enable icon.

Step 6 Click OK.

Step 7 In the Exchange Management Console, go to Microsoft Exchange > Server Configuration > Client 
Access.

Step 8 Click the Outlook Web Access tab in the lower-middle pane.

Step 9 Right-click OWA and click Properties.

Step 10 In the Properties dialog box, click the Authentication tab.

Step 11 Click Use One or More Standard Authentication Methods.

Step 12 Check the check boxes for one or more of the following options:

• Basic

• Digest

• Integrated Windows Authentication

Step 13 Click OK.

Step 14 Open the IIS Manager application.

Step 15 Go to IIS > <server name> > Web Sites > Default Web Site.

Step 16 Right-click Default Web Site and click Properties.

Step 17 In the Properties dialog box, click the Directory Security tab.

Step 18 Under Authentication and Access Control, click Edit.

Step 19 Confirm that the enabled authentication schemes match those that you enabled in Step 12.

Step 20 Click OK.

Step 21 In the Properties dialog box, click OK.
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Step 22 Open the Exchange Management Shell.

Step 23 In the Exchange Management Shell, enter the following command:

iisbreset /noforce

Step 24 Press Enter.

To Configure Secure Access to Exchange 2007 for the Calendar Integration (With SSL)

Note If you have already configured secure IMAP with SSL and have enabled the certificate for both 
IMAP and IIS, then you can skip the following procedure and continue with the “Configuring 
Cisco Unity Connection for the Exchange 2007 Calendar Integration” section on page 35-5.

Step 1 On the Exchange Server, open the Exchange Management Shell application.

Step 2 Enter the following command, where <Exchange server> is the IP address or host name of the Exchange 
server and <friendly name> is the friendly name that you chose for the Exchange server:

• new-exchangecertificate -generaterequest -domainname <Exchange server> -friendlyname 
<friendly name>-path c:\csr.txt

Caution The domain name for the Exchange server must be the IP address or the fully qualified DNS 
name (recommended) so that the Connection server can successfully ping the Exchange 
server. Otherwise, the calendar integration may not function correctly.

Step 3 Press Enter.

A Certificate Signing Request (CSR) file with the name Csr.txt is created in the root directory.

Step 4 Send the CSR file to a Certification Authority (CA), which generates and sends back a new certificate.

Note You must have a copy of the CA public root certificate or public root certificate chain. This 
certificate is needed for configuring Connection to trust the Exchange 2007 server.

Step 5 Enter the following command, where <path> is the location of the directory where the CA saves the new 
server certificate:

import-exchangecertificate -path <path>

Step 6 Press Enter.

Step 7 Enter the following command:

dir cert:\localmachine\my | fl

Step 8 Press Enter.

Step 9 Highlight the “thumbprint” property and press Ctrl-C to copy it to the clipboard.

Step 10 If Connection will be configured to use IMAP to access email from an external email server and use 
calendar data from Exchange 2007, enter the following command, where <thumbprint> is the 
“thumbprint” that you copied in Step 9:

enable-exchangecertificate -thumbprint <thumbprint> -services "IIS,IMAP"
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If Connection will not be configured to use IMAP but will be configured to use calendar data from 
Exchange 2007, enter the following command, where <thumbprint> is the “thumbprint” that you copied 
in Step 9:

enable-exchangecertificate -thumbprint <thumbprint> -services "IIS"

Step 11 Press Enter.

Step 12 If you want data transmitted as clear text, skip the remaining steps in this procedure and continue with 
the “Configuring Cisco Unity Connection for the Exchange 2007 Calendar Integration” section on 
page 35-5. Otherwise, open the IIS Manager application.

Step 13 Go to IIS > <server name> > Web Sites > Default Web Site.

Step 14 Right-click Default Web Site and click Properties.

Step 15 In the Properties dialog box, click the Directory Security tab.

Step 16 Under Secure Communications, click Edit.

Step 17 Check the Require Secure Channel check box.

Step 18 Click OK.

Step 19 In the Properties dialog box, click OK.

Configuring Cisco Unity Connection for the Exchange 2007 Calendar Integration
Do the following procedure.

To Configure Cisco Unity Connection for the Exchange 2007 Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then click External Services.

Step 2 On the Search External Services page, click Add New.

Step 3 On the New External Service page, in the Type list, click Exchange 2007 External Service Template.

Step 4 Check the Enabled check box to enable the calendar integration.

Step 5 In the Display Name field, enter a descriptive name.

Step 6 In the Server field, enter the IP address or host name for the Exchange 2007 server.

Step 7 In the Authentication Mode field, click the applicable setting to match the authentication mode that is 
used by the Exchange server.

Step 8 In the Security Transport field, click the applicable setting:

• None—Connection does not use a secure connection with the Exchange 2007 server.

• SSL—Connection uses an SSL connection with the Exchange 2007 server.

Step 9 If you selected “SSL” and you want Connection to validate the Exchange 2007 server certificate, check 
the Validate Server Certificate check box.
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Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 10 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Step 11 Click Verify. A message appears indicating whether the Cisco Unity Connection configuration has been 
successfully verified.

If the verification fails, confirm the configuration for Exchange 2007 and Cisco Unity Connection.

Step 12 Click Save.

Configuring Users for the Exchange 2007 Calendar Integration
Do the following procedure.

Note Exchange 2007 must have a user for each Connection user that you are configuring.

To Configure Users for the Exchange 2007 Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.

Step 2 On the Search Users page, click the alias of a user.

Note If the user alias does not appear in the search results table, set the applicable parameters in the 
search fields at the top of the page, and click Search.

Step 3 On the Edit User Basics page, on the Edit menu, click External Service Accounts.

Step 4 On the External Service Accounts page, click Add New.

Step 5 On the New External Service Accounts page, in the External Service field, click the display name that 
you entered in the “To Configure Cisco Unity Connection for the Exchange 2007 Calendar Integration” 
procedure on page 35-5.

Step 6 In the Email Address field, enter the email address in Exchange 2007 for the user.

Step 7 In the Login Type field, click the applicable option:

• Use Connection Alias—This option is useful when the Windows domain alias for the user is the 
same as the Connection user alias. Connection logs on the user with the Connection user alias.

• Use User ID Provided Below—(Recommended) Enter the Windows domain alias for the user 
(useful when the User ID setting is different from the Connection user alias). Connection logs on 
the user with the setting in this field.
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Step 8 (Only when the Use User ID Provided Below option is selected in Step 7) In the User ID field, enter the 
User ID setting from Exchange 2007.

Step 9 If known, in the Password field, enter the Windows domain password for the user. Connection logs on 
the user with the setting in this field.

Note If you leave the Password field blank, users must log on to Cisco Personal Communications 
Assistant and enter their password on the External Services Accounts page. For details, see the 
“Changing Your Cisco Unity Connection Passwords” chapter of the User Guide for the 
Cisco Unity Connection Assistant Web Tool Release 7.x.

Step 10 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

Step 11 Click Save.

Step 12 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Exchange 2007, Cisco Unity Connection, and the 
user.

Step 13 Repeat Step 2 through Step 12 for all remaining users.

Testing the Exchange 2007 Calendar Integration
Do the following procedure.

To Test the Configuration for the Exchange 2007 Calendar Integration

Step 1 Log in to Outlook.

Step 2 On the Go menu, click Calendar.

Step 3 On the File menu, click New > Meeting Request.

Step 4 Enter values in the required fields to schedule a new meeting for the current time, and invite a user who 
has an account on Cisco Unity Connection.

Step 5 Click Send.

Step 6 Log on to the Cisco Unity Connection mailbox of the user that you invited to the Outlook meeting in 
Step 4.

Step 7 If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list 
meetings.

Connection reads the information about the Exchange 2007 meeting.
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Changing the Cisco Unity Connection Configuration for the Exchange 2007 
Calendar Integration

You can change the Cisco Unity Connection configuration after the calendar integration was created. Do 
the following procedure.

To Change the Cisco Unity Connection Configuration for the Exchange 2007 Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then click External Services.

Step 2 On the Search External Services page, click the name of the external service that you created when you 
integrated Connection with Exchange 2007.

Step 3 Check the Enabled check box to enable the external service.

When this check box is not checked, the integration with Exchange 2007 is disabled.

Step 4 In the Display Name field, enter a descriptive name.

Step 5 In the Server field, enter the IP address or host name for the Exchange 2007 server.

Step 6 In the Authentication Mode field, click the applicable setting to match the authentication mode that is 
used by the Exchange server.

Step 7 In the Security Transport field, click the applicable setting:

• None—Connection does not use a secure connection with the Exchange 2007 server.

• SSL—Connection uses an SSL connection with the Exchange 2007 server.

Step 8 If you selected “SSL” and you want Connection to validate the Exchange 2007 server certificate, check 
the Validate Server Certificate check box.

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 9 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Step 10 Click Save.

Step 11 To check the integration with Exchange 2007, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Exchange 2007 and Cisco Unity Connection.

Changing the User Configuration for the Exchange 2007 Calendar Integration
You can change the user configuration after the calendar integration was created. Do the following 
procedure.
35-8
System Administration Guide for Cisco Unity Connection Release 7.x

OL-17017-01



Chapter 35      Creating Calendar Integrations
  Creating a Calendar Integration with Exchange 2007
To Change the User Configuration for the Exchange 2007 Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.

Step 2 On the Search Users page, click the alias of a user.

Note If the user alias does not appear in the search results table, set the applicable parameters in the 
search fields at the top of the page, and click Search.

Step 3 On the Edit User Basics page, on the Edit menu, click External Service Accounts.

Step 4 On the External Service Accounts page, in the Display Name column, click the display name for the 
Exchange 2007 service.

Step 5 On the Edit External Services Account page, in the Email Address field, enter the email address in 
Exchange 2007 for the user.

Step 6 In the Login Type field, click the applicable option:

• Use Connection Alias—This option is useful when the Windows domain alias for the user is the 
same as the Connection user alias. Connection logs on the user with the Connection user alias.

• Use User ID Provided Below—(Recommended) Enter the Windows domain alias for the user 
(useful when the User ID setting is different from the Connection user alias). Connection logs on 
the user with the setting in this field.

Step 7 (Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the 
User ID setting from Exchange 2007.

Step 8 If known, in the Password field, enter the Windows domain password for the user. Connection logs on 
the user with the setting in this field.

Note If you leave the Password field blank, users must log on to Cisco Personal Communications 
Assistant and enter their password on the External Services Accounts page. For details, see the 
“Changing Your Cisco Unity Connection Passwords” chapter of the User Guide for the 
Cisco Unity Connection Assistant Web Tool Release 7.x.

Step 9 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

Step 10 Click Save.

Step 11 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Exchange 2007, Cisco Unity Connection, and the 
user.
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Creating a Calendar Integration with Exchange 2003
If you have Exchange 2003 installed, you can integrate Cisco Unity Connection with Exchange 2003 so 
that users can do the following:

• Review upcoming meetings by phone or while using the Cisco Personal Communications Assistant 
(PCA).

• Import Exchange contacts. The contact information can be used in rules that users create in the 
Personal Call Transfer Rules web tool and when users place outgoing calls by using voice 
commands.

Task List for Creating a Calendar Integration with Exchange 2003
1. Review the system requirements to confirm that all requirements for Exchange 2003 and the 

Cisco Unity Connection server have been met. See the “Requirements for the Exchange 2003 
Calendar Integration” section on page 35-10.

2. Configure Exchange 2003. See the “Configuring Exchange 2003 for the Calendar Integration” 
section on page 35-11.

3. Configure Connection. See the “Configuring Cisco Unity Connection for the Exchange 2003 
Calendar Integration” section on page 35-14.

4. (When enabling personal call transfer rules only) Verify that the users or templates are associated 
with a class of service that enables them to use the personal call transfer rules feature.

5. Configure the Connection users. See the “Configuring Users for the Exchange 2003 Calendar 
Integration” section on page 35-15.

6. Test the calendar integration. See the “Testing the Exchange 2003 Calendar Integration” section on 
page 35-16.

7. To teach users how to use the Connection calendar, refer them to the following:

• For listing, joining, and scheduling meetings, see the “Cisco Unity Connection Phone Menus and 
Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone Interface 
(Release 7.x).

• For importing Exchange contacts, see the “Managing Your Personal Contacts” chapter of the User 
Guide for the Cisco Unity Connection Assistant Web Tool (Release 7.x).

• For using personal call transfer rules, see the User Guide for the Cisco Unity Connection Personal 
Call Transfer Rules Web Tool (Release 7.x) at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/user/guide/pctr/7xcucugpctrx.ht
ml.

Note You can change the Cisco Unity Connection configuration and the user configuration after the calendar 
integration is created. See the “Changing the Cisco Unity Connection Configuration for the Exchange 
2003 Calendar Integration” section on page 35-16 and the “Changing the User Configuration for the 
Exchange 2003 Calendar Integration” section on page 35-17.

Requirements for the Exchange 2003 Calendar Integration
Revised May 2009
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The calendar integration with Exchange 2003 has the following requirements:

• Exchange 2003 as described in the “Requirements for Accessing Calendar Information for 
Meetings” section of System Requirements for Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html
.

• Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection 
Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/installation/guide/7xcucigx.html
.

Configuring Exchange 2003 for the Calendar Integration
Do the applicable procedures.

To Create the Privileged Service Account for the Exchange 2003 Calendar Integration

Step 1 On the Domain Controller, open Active Directory Users and Computers.

Step 2 Right-click Users and click New > User.

Step 3 Create a domain user account with alias cucsvc.

Note It is not necessary to create a mailbox for this user.

Step 4 On the Exchange server, go to Microsoft Exchange > System Manager.

Step 5 Under Servers, right-click the server name and click Properties.

Step 6 In the Properties dialog box, click the Security tab.

Step 7 Click Add and add cucsvc (the alias for the domain account that you created in Step 3) to the list of 
accounts with permissions on the store.

Step 8 Click Check Names.

Step 9 Click OK.

Step 10 In the list, click cucsvc (the alias for the domain account that you created in Step 3).

Step 11 Set the permissions for the domain account alias to allow for Receive As, Send As, and Administer 
Information Store. Deny all other permissions.

Step 12 In the Properties dialog box, click OK.

If you are not using SSL for access to the Exchange 2003 server, do the “To Configure Basic Access to 
Exchange 2003 for the Calendar Integration (Without SSL)” procedure on page 35-11.

If you are using SSL for secure access to the Exchange 2003 server, do the “To Configure Secure Access 
to Exchange 2003 for the Calendar Integration (With SSL)” procedure on page 35-13.

To Configure Basic Access to Exchange 2003 for the Calendar Integration (Without SSL)

Step 1 On the Domain Controller, go to Active Directory Users and Computers.
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Step 2 Under Users, select all user accounts with calendars that you want Connection to access.

Step 3 Right-click the highlighted users and click Exchange Tasks.

Step 4 In the Exchange Tasks dialog box, click Configure Exchange Features.

Step 5 Under Protocols, click Outlook Web Access.

Step 6 Click the Enable icon.

Step 7 Click Next.

Step 8 Click Finish.

Step 9 On the Exchange server, open the Exchange System Manager application.

Step 10 Go to Servers > <server name> > Protocols > HTTP > Exchange Virtual Server.

Step 11 Click the Settings tab.

Step 12 Confirm that the Enable Forms Based Authentication check box is unchecked.

Step 13 Click OK.

Step 14 Go to Servers > <server name> > Protocols > HTTP > Exchange Virtual Server > Exchange.

Step 15 Right-click Exchange and click Properties.

Step 16 In the Properties dialog box, click the Access tab.

Step 17 Confirm that the following check boxes are checked:

• Read

• Write

• Directory Browsing

Step 18 Click Authentication.

Step 19 Confirm that one or more of the following options are enabled:

• Basic

• Digest

• Integrated Windows Authentication

Step 20 Click OK.

Step 21 In the Properties dialog box, click OK.

Step 22 Open the IIS Manager application.

Step 23 Go to IIS > <server name> > Web Sites > Default Web Site.

Step 24 Right-click Default Web Site and click Properties.

Step 25 In the Properties dialog box, click the Directory Security tab.

Step 26 Under Authentication and Access Control, click Edit.

Step 27 Confirm that the enabled authentication schemes match those that you enabled in Step 19.

Step 28 Click OK.

Step 29 In the Properties dialog box, click OK.
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To Configure Secure Access to Exchange 2003 for the Calendar Integration (With SSL)

Step 1 On the Exchange server, open the IIS Manager application.

Step 2 Go to IIS > Web Sites > Default Web Site.

Step 3 Right-click Default Web Site and click Properties.

Step 4 In the Properties dialog box, click the Directory Security tab.

Step 5 Under Secure Communications, click Server Certificate.

Step 6 Click Next.

Step 7 Click Create a New Certificate.

Note If this option is not available, you must remove the existing certificate and do this step again.

Step 8 Click Prepare the Request Now, But Send It Later.

Step 9 Follow the prompts in the wizard to enter the applicable information for your organization.

Caution The “common name” for the Exchange server certificate must be the IP address or the fully 
qualified DNS name (recommended) of the Exchange server. Otherwise, the calendar 
integration may not function correctly.

Step 10 Save the Certificate Signing Request (CSR) as a file.

Step 11 Send the CSR file to a Certification Authority (CA), which generates and sends back a new certificate.

Note You must have a copy of the CA public root certificate or public root certificate chain. This 
certificate is needed for configuring Connection to trust the Exchange 2003 server.

Step 12 Return to the IIS Manager application.

Step 13 Go to IIS > Web Sites > Default Web Site.

Step 14 Right-click Default Web Site and click Properties.

Step 15 In the Properties dialog box, click the Directory Security tab.

Step 16 Under Secure Communications, click Server Certificate.

Step 17 Click Next.

Step 18 Click Process the Pending Request and Install the Certificate and click Next.

Step 19 Browse to the local file system and click the new certificate that CA sent.

Step 20 Click Next.

Step 21 Confirm that the certificate information is valid and click Next.

Step 22 Click Finish.

Step 23 In the Properties dialog box, click OK.

Step 24 Return to the IIS Manager application.

Step 25 Go to IIS > <sever name> > Web Sites > Default Web Site.

Step 26 Right-click Default Web Site and click Properties.
35-13
System Administration Guide for Cisco Unity Connection Release 7.x

OL-17017-01



Chapter 35      Creating Calendar Integrations
  Creating a Calendar Integration with Exchange 2003
Step 27 In the Properties dialog box, click the Directory Security tab.

Step 28 Under Secure Communications, click Edit.

Step 29 Check the Require Secure Channel check box.

Step 30 Click OK.

Step 31 In the Properties dialog box, click OK.

Configuring Cisco Unity Connection for the Exchange 2003 Calendar Integration
Do the following procedure.

To Configure Cisco Unity Connection for the Exchange 2003 Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then click External Services.

Step 2 On the Search External Services page, click Add New.

Step 3 On the New External Service page, in the Type list, click Exchange 2003 External Service Template.

Step 4 Check the Enabled check box to enable the external service.

When this check box is not checked, the integration with Exchange 2003 is disabled.

Step 5 In the Display Name field, enter a descriptive name.

Step 6 In the Server field, enter the IP address or host name for the Exchange 2003 server.

Step 7 In the Authentication Mode field, click the applicable setting to match the authentication mode that is 
used by the Exchange server.

Step 8 In the Security Transport field, click the applicable setting:

• None—Connection does not use a secure connection with the Exchange 2003 server.

• SSL—Connection uses an SSL connection with the Exchange 2003 server.

Step 9 If you selected “SSL” and you want Connection to validate the Exchange 2003 server certificate, check 
the Validate Server Certificate check box.

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 10 In the Alias field, enter the Windows domain alias for the privileged service account that Connection 
uses to log on to the Exchange 2003 server.

This setting must match the user ID for the privileged service account that is configured in Exchange 
2003.
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Step 11 In the Password field, enter the password for the privileged service account that Connection uses to log 
on to the Exchange 2003 server.

This setting must match the user password for the privileged service account that is configured in 
Exchange 2003.

Step 12 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Step 13 Click Save.

Step 14 To check the integration with Exchange 2003, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Exchange 2003 and Cisco Unity Connection.

Configuring Users for the Exchange 2003 Calendar Integration
Do the following procedure.

Note Exchange 2003 must have a user for each Connection user that you are configuring.

To Configure Users for the Exchange 2003 Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.

Step 2 On the Search Users page, click the alias of a user.

Note If the user alias does not appear in the search results table, set the applicable parameters in the 
search fields at the top of the page, and click Search.

Step 3 On the Edit User Basics page, on the Edit menu, click External Service Accounts.

Step 4 On the External Service Accounts page, click Add New.

Step 5 On the New External Service Accounts page, in the External Service field, click the display name that 
you entered in the “To Configure Cisco Unity Connection for the Exchange 2003 Calendar Integration” 
procedure on page 35-14.

Step 6 In the Email Address field, enter the primary SMTP address in Exchange 2003 for the user.

Step 7 In the Login Type field, click the applicable option:

• Use Connection Alias—This option is useful when the User ID setting in Exchange 2003 is the 
same as the Connection user alias. Connection logs on the user with the Connection user alias.

• Use User ID Provided Below—Enter the User ID setting from Exchange 2003 (useful when the 
User ID setting is different from the Connection user alias). Connection logs on the user with the 
setting in this field.

Step 8 (Only when the Use User ID Provided Below option is selected in Step 7) In the User ID field, enter the 
User ID setting from Exchange 2003.

Step 9 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.
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Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

Step 10 Click Save.

Step 11 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Exchange 2003, Cisco Unity Connection, and the 
user.

Step 12 Repeat Step 2 through Step 11 for all remaining users.

Testing the Exchange 2003 Calendar Integration
Do the following procedure.

To Test the Exchange 2003 Calendar Integration

Step 1 Log in to Outlook.

Step 2 On the Go menu, click Calendar.

Step 3 On the File menu, click New > Meeting Request.

Step 4 Enter values in the required fields to schedule a new meeting for the current time, and invite a user who 
has an account on Cisco Unity Connection.

Step 5 Click Send.

Step 6 Log on to the Connection mailbox of the user that you invited to the Outlook meeting in Step 4.

Step 7 If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list 
meetings.

Connection reads the information about the Exchange 2003 meeting.

Changing the Cisco Unity Connection Configuration for the Exchange 2003 
Calendar Integration

You can change the Cisco Unity Connection configuration after the calendar integration was created. Do 
the following procedure.

To Change the Cisco Unity Connection Configuration for the Exchange 2003 Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then click External Services.

Step 2 On the Search External Services page, click the name of the external service that you created when you 
integrated Connection with Exchange 2003.
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Step 3 Check the Enabled check box to enable the external service.

When this check box is not checked, the integration with Exchange 2003 is disabled.

Step 4 In the Display Name field, enter a descriptive name.

Step 5 In the Server field, enter the IP address or host name for the Exchange 2003 server.

Step 6 In the Authentication Mode field, click the applicable setting to match the authentication mode that is 
used by the Exchange server.

Step 7 In the Security Transport field, click the applicable setting:

• None—Connection does not use a secure connection with the Exchange 2003 server.

• SSL—Connection uses an SSL connection with the Exchange 2003 server.

Step 8 If you selected “SSL” and you want Connection to validate the Exchange 2003 server certificate, check 
the Validate Server Certificate check box.

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 9 In the Alias field, enter the Windows domain alias for the privileged service account that Connection 
uses to log on to the Exchange 2003 server.

This setting must match the user ID for the privileged service account that is configured in Exchange 
2003.

Step 10 In the Password field, enter the password for the privileged service account that Connection uses to log 
on to the Exchange 2003 server.

This setting must match the user password for the privileged service account that is configured in 
Exchange 2003.

Step 11 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Step 12 Click Save.

Step 13 To check the integration with Exchange 2003, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Exchange 2003 and Cisco Unity Connection.

Changing the User Configuration for the Exchange 2003 Calendar Integration
You can change the user configuration after the calendar integration was created. Do the following 
procedure.
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To Change the User Configuration for the Exchange 2003 Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.

Step 2 On the Search Users page, click the alias of a user.

Step 3 On the Edit User Basics page, on the Edit menu, click External Service Accounts.

Step 4 On the External Service Accounts page, in the Display Name column, click the display name for the 
Exchange 2003 service.

Step 5 In the Email Address field, enter the primary SMTP address in Exchange 2003 for the user.

Step 6 On the Edit External Services Account page, in the Login Type field, click the applicable option:

• Use Connection Alias—This option is useful when the User ID setting in Exchange 2003 is the 
same as the Connection user alias. Connection logs on the user with the Connection user alias.

• Use User ID Provided Below—Enter the User ID setting from Exchange 2003 (useful when the 
User ID setting is different from the Connection user alias). Connection logs on the user with the 
setting in this field.

Step 7 (Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the 
User ID setting from Exchange 2003.

Step 8 Under Service Capabilities, check the User Access to Calendar and Personal Contacts check box.

Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

Step 9 Click Save.

Step 10 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Exchange 2003, Cisco Unity Connection, and the 
user.

Creating a Calendar Integration with Cisco Unified 
MeetingPlace

If you have Cisco Unified MeetingPlace installed, you can integrate Cisco Unity Connection with Cisco 
Unified MeetingPlace so that users can review upcoming meetings and join active meetings by phone.

Task List for Creating a Calendar Integration with Cisco Unified MeetingPlace
1. Review the system requirements to confirm that all requirements for Cisco Unified MeetingPlace 

and the Cisco Unity Connection server have been met. See the “Requirements for the Cisco Unified 
MeetingPlace Calendar Integration” section on page 35-19.

2. Configure Cisco Unified MeetingPlace. See the “Configuring Cisco Unified MeetingPlace for the 
Calendar Integration” section on page 35-19.
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3. Configure Connection. See the “Configuring Cisco Unity Connection for the Cisco Unified 
MeetingPlace Calendar Integration” section on page 35-20.

4. Configure the Connection users. See the “Configuring Users for the Cisco Unified MeetingPlace 
Calendar Integration” section on page 35-21.

5. Test the calendar integration. See the “Testing the Calendar Integration for the Cisco Unified 
MeetingPlace Calendar Integration” section on page 35-23.

6. To teach users how to list, join, and schedule meetings, see the “Cisco Unity Connection Phone 
Menus and Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone 
Interface (Release 7.x).

Note You can change the Cisco Unity Connection configuration and the user configuration after the calendar 
integration is created. See the “Changing the Cisco Unity Connection Configuration for the Cisco 
Unified MeetingPlace Calendar Integration” section on page 35-23 and the “Changing the User 
Configuration for the Cisco Unified MeetingPlace Calendar Integration” section on page 35-24.

Requirements for the Cisco Unified MeetingPlace Calendar Integration
Revised May 2009
The calendar integration with Cisco Unified MeetingPlace has the following requirements:

• Cisco Unified MeetingPlace as described in the “Requirements for Accessing Calendar Information 
for Meetings” section of System Requirements for Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html
.

• Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection 
Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/installation/guide/7xcucigx.html
.

Configuring Cisco Unified MeetingPlace for the Calendar Integration
Do the following procedure.

To Configure Cisco Unified MeetingPlace for the Calendar Integration

Step 1 Log on to the Cisco Unified MeetingPlace Administration Server as an administrator.

Step 2 Click User Configuration > User Profiles.

Step 3 Click Add New.

Step 4 Enter the following values in the required fields to create a privileged service account:

First Name Leave this field blank.

Last Name Enter Cisco Unity Connection.

User ID Enter cucsvc or another user ID that you want.

User Password Enter the applicable password.
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Note The values that you enter for the User ID, User Password, Profile Number, and Profile Password 
fields will be used in the “Configuring Cisco Unity Connection for the Cisco Unified 
MeetingPlace Calendar Integration” section on page 35-20.

Step 5 Click Save.

Step 6 Log off of Cisco Unified MeetingPlace.

Caution If you do not log off of Cisco Unified MeetingPlace, the test will fail in the “To Test the Cisco 
Unified MeetingPlace Configuration for the Calendar Integration” procedure on page 35-20.

To Test the Cisco Unified MeetingPlace Configuration for the Calendar Integration

Step 1 In the Address field of a web browser, if SSL is not enabled, enter the following URL (where <server> 
is the IP address or host name of the Cisco Unified MeetingPlace server):

http://<server>/webservices/services/meetingservice?wsdl

If SSL is enabled, enter the following URL:

https://<server>/webservices/services/meetingservice?wsdl

Step 2 Press Enter.

Step 3 When prompted to log in, enter the user ID and password for the privileged service account that you 
created in the “To Configure Cisco Unified MeetingPlace for the Calendar Integration” procedure on 
page 35-19.

The Cisco Unified MeetingPlace WSDL download page appears with the title “XFire Services.”

Configuring Cisco Unity Connection for the Cisco Unified MeetingPlace 
Calendar Integration

Do the following procedure.

To Configure Cisco Unity Connection for the Cisco Unified MeetingPlace Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then click External Services.

Step 2 On the Search External Services page, click Add New.

Step 3 On the New External Service page, in the Type list, click MeetingPlace 7.0 External Service Template.

Step 4 Check the Enabled check box to enable the external service.

Profile Number Enter the applicable profile number.

Profile Password Enter the applicable profile password.

Type of User Click System Administrator.
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When this check box is not checked, the integration with Cisco Unified MeetingPlace is disabled.

Step 5 In the Display Name field, enter a descriptive name.

Step 6 In the Server field, enter the IP address or host name for the Cisco Unified MeetingPlace server.

Step 7 In the Transfer Extension Dial String field, enter the digits that Connection must dial to transfer users 
on the phone to the opening greeting of Cisco Unified MeetingPlace server.

Step 8 In the Security Transport field, click the applicable setting:

• None—Connection does not use a secure connection with the Cisco Unified MeetingPlace server.

• SSL—Connection uses an SSL connection with the Cisco Unified MeetingPlace server.

Step 9 If you selected “SSL” and you want Connection to validate the Cisco Unified MeetingPlace server 
certificate, check the Validate Server Certificate check box.

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 10 In the Alias field, enter the Windows domain alias for the privileged service account that Connection 
uses to log on to the Cisco Unified MeetingPlace server.

This setting must match the User ID setting for the privileged service account that you configured in the 
“Configuring Cisco Unified MeetingPlace for the Calendar Integration” section on page 35-19.

Step 11 In the Password field, enter the password for the privileged service account that Connection uses to log 
on to the Cisco Unified MeetingPlace server.

This setting must match the User Password setting for the privileged service account that you configured 
in the “Configuring Cisco Unified MeetingPlace for the Calendar Integration” section on page 35-19.

Step 12 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that users can hear of their upcoming meetings 
by phone.

• MeetingPlace Scheduling and Joining—Check this check box so that users can schedule and join 
meetings.

Step 13 Click Save.

Step 14 To check the integration with Cisco Unified MeetingPlace, click Test. The Task Execution Results 
window appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace and Cisco Unity 
Connection.

Configuring Users for the Cisco Unified MeetingPlace Calendar Integration
Do the following procedure.
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Note Cisco Unified MeetingPlace must have an end user for each Connection user that you are configuring.

To Configure Users for the Cisco Unified MeetingPlace Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.

Step 2 On the Search Users page, click the alias of a user.

Step 3 On the Edit User Basics page, on the Edit menu, click External Service Accounts.

Step 4 On the External Service Accounts page, click Add New. The New External Service Account page 
appears.

Step 5 In the External Service field, click the display name that you entered in the “Configuring Cisco Unity 
Connection for the Cisco Unified MeetingPlace Calendar Integration” section on page 35-20.

Step 6 In the Login Type field, click the applicable option:

• Use Connection Alias—This option is useful when the Cisco Unified MeetingPlace profile alias is 
the same as the Connection user alias. Connection logs on the user with the Connection user alias. 
Cisco Unified MeetingPlace provides information on public and private meetings to the user.

• Use Server Guest Account—Connection logs on the user as a guest, without using the Connection 
user alias or the User ID setting. Cisco Unified MeetingPlace provides information only on public 
meetings to the user.

• Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace (useful 
when the Cisco Unified MeetingPlace profile alias is different from the Connection user alias). 
Connection logs on the user with the setting in this field. Cisco Unified MeetingPlace provides 
information on public and private meetings to the user.

Step 7 (Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the 
User ID setting from Cisco Unified MeetingPlace.

Step 8 Under Service Capabilities, check the applicable check boxes:

• MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and 
join meetings.

• Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for 
two or more external services, check this check box so that Cisco Unified MeetingPlace meetings 
will be set up through this Cisco Unified MeetingPlace server. Uncheck this check box so that Cisco 
Unified MeetingPlace meetings will be set up through another server.

Step 9 Click Save.

Step 10 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace, Cisco Unity 
Connection, and the user.

Step 11 Repeat Step 2 through Step 10 for all remaining users.
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Testing the Calendar Integration for the Cisco Unified MeetingPlace Calendar 
Integration

Do the following procedure.

To Test the Configuration for the Cisco Unified MeetingPlace Calendar Integration

Step 1 Log in to Cisco Unified MeetingPlace as an end user.

Step 2 Click Schedule.

Step 3 Enter values in the required fields to schedule a new meeting for the current time, and invite a user who 
has an account on Cisco Unity Connection.

Step 4 Log on to the Connection mailbox of the user that you invited to the Cisco Unified MeetingPlace meeting 
in Step 3.

Step 5 If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list 
meetings.

Step 6 When you hear the system announce the Cisco Unified MeetingPlace meeting that you just scheduled, 
either say Join, or press the applicable keys on the phone keypad to join the meeting.

Changing the Cisco Unity Connection Configuration for the Cisco Unified 
MeetingPlace Calendar Integration

You can change the Cisco Unity Connection configuration after the calendar integration was created. Do 
the following procedure.

To Change the Cisco Unity Connection Configuration for the Cisco Unified MeetingPlace Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then click External Services.

Step 2 On the Search External Services page, click the display name of the external service that you created 
when you integrated Connection with Cisco Unified MeetingPlace.

Step 3 Verify that MeetingPlace 7.0 is listed in the Display Name column for the integration.

Step 4 Click the display name of the external service that you created when you integrated Connection with 
Cisco Unified MeetingPlace.

Step 5 To enable the calendar integration, check the Enabled check box. To disable the calendar integration, 
uncheck the Enabled check box.

Step 6 In the Display Name field, enter a descriptive name.

Step 7 In the Server field, enter the IP address or host name for the Cisco Unified MeetingPlace server.

Step 8 In the Transfer Extension Dial String field, enter the digits that Connection must dial to transfer users 
on the phone to the opening greeting of Cisco Unified MeetingPlace server.

Step 9 In the Security Transport field, click the applicable setting:

• None—Connection does not use a secure connection with the Cisco Unified MeetingPlace server.
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• SSL—Connection uses an SSL connection with the Cisco Unified MeetingPlace server.

Step 10 If you selected “SSL” and you want Connection to validate the Cisco Unified MeetingPlace server 
certificate, check the Validate Server Certificate check box.

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority 
(CA) that signed the server certificate must be installed as Connection-trust certificates in 
Cisco Unified Operating System Administration. Otherwise, validation of the server 
certificate will fail.

Step 11 In the Alias field, enter the Windows domain alias for the privileged service account that Connection 
uses to log on to the Cisco Unified MeetingPlace server.

This setting must match the User ID setting for the privileged service account that you configured in the 
“Configuring Cisco Unified MeetingPlace for the Calendar Integration” section on page 35-19.

Step 12 In the Password field, enter the password for the privileged service account that Connection uses to log 
on to the Cisco Unified MeetingPlace server.

This setting must match the User Password setting for the API user that you configured in the 
“Configuring Cisco Unified MeetingPlace for the Calendar Integration” section on page 35-19.

Step 13 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that users can hear their upcoming meetings 
by phone.

• MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and 
join meetings.

Step 14 Click Save.

Step 15 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace, Cisco Unity 
Connection, and the user.

Changing the User Configuration for the Cisco Unified MeetingPlace Calendar 
Integration

You can change the user configuration after the calendar integration was created. Do the following 
procedure.

To Change the User Configuration for the Cisco Unified MeetingPlace Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.

Step 2 On the Search Users page, click the alias of a user.

Step 3 On the Edit User Basics page, on the Edit menu, click External Service Accounts.
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Step 4 On the External Service Accounts page, in the Display Name column, click the display name for the 
Cisco Unified MeetingPlace service.

Step 5 On the Edit External Service Account page, in the Login Type field, click the applicable option:

• Use Connection Alias—This option is useful when the Cisco Unified MeetingPlace profile alias is 
the same as the Connection user alias. Connection logs on the user with the Connection user alias. 
Cisco Unified MeetingPlace provides information on public and private meetings to the user.

• Use Server Guest Account—Connection logs on the user as a guest, without using the Connection 
user alias or the User ID setting. Cisco Unified MeetingPlace provides information only on public 
meetings to the user.

• Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace (useful 
when the Cisco Unified MeetingPlace profile alias is different from the Connection user alias). 
Connection logs on the user with the setting in this field. Cisco Unified MeetingPlace provides 
information on public and private meetings to the user.

Step 6 (Only when the Use User ID Provided Below option is selected in Step 5) In the User ID field, enter the 
User ID setting from Cisco Unified MeetingPlace.

Step 7 Under Service Capabilities, check the applicable check boxes:

• MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and 
join meetings.

• Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for 
two or more external services, check this check box so that Cisco Unified MeetingPlace meetings 
will be set up through this Cisco Unified MeetingPlace server. Uncheck this check box so that Cisco 
Unified MeetingPlace meetings will be set up through another server.

Step 8 Click Save.

Step 9 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace, Cisco Unity 
Connection, and the user.

Creating a Calendar Integration with Cisco Unified 
MeetingPlace Express

If you have Cisco Unified MeetingPlace Express installed, you can integrate Cisco Unity Connection 
with Cisco Unified MeetingPlace Express so that users can review upcoming meetings and join active 
meetings by phone or while using the Cisco Personal Communications Assistant (PCA).

Use the following task list to create a calendar integration.

Task List for Creating a Calendar Integration with Cisco Unified MeetingPlace 
Express

1. Review the system requirements to confirm that all requirements for Cisco Unified MeetingPlace 
Express and the Cisco Unity Connection server have been met. See the “Requirements for the Cisco 
Unified MeetingPlace Express Calendar Integration” section on page 35-26.
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2. Configure Cisco Unified MeetingPlace Express. See the “Configuring Cisco Unified MeetingPlace 
Express for the Calendar Integration” section on page 35-26.

3. Configure Connection. See the “Configuring Cisco Unity Connection for the Cisco Unified 
MeetingPlace Express Calendar Integration” section on page 35-27.

4. Configure the Connection users. See the “Configuring Users for the Cisco Unified MeetingPlace 
Express Calendar Integration” section on page 35-29.

5. Test the calendar integration. See the “Testing the Cisco Unified MeetingPlace Express Calendar 
Integration” section on page 35-30.

6. To teach users how to list, join, and schedule meetings, see the “Cisco Unity Connection Phone 
Menus and Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone 
Interface (Release 7.x).

Note You can change the Cisco Unity Connection configuration and the user configuration after the calendar 
integration is created. See the “Changing the Cisco Unity Connection Configuration for the Cisco 
Unified MeetingPlace Express Calendar Integration” section on page 35-30 and the “Changing the User 
Configuration for the Cisco Unified MeetingPlace Express Calendar Integration” section on page 35-32.

Requirements for the Cisco Unified MeetingPlace Express Calendar Integration
Revised May 2009
The calendar integration with Cisco Unified MeetingPlace Express has the following requirements:

• Cisco Unified MeetingPlace Express as described in the “Requirements for Accessing Calendar 
Information for Meetings” section of System Requirements for Cisco Unity Connection Release 7.x 
at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html
.

• Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection 
at http://www.cisco.com/en/US/products/ps6509/prod_installation_guides_list.html.

Configuring Cisco Unified MeetingPlace Express for the Calendar Integration
Do the following procedure.

To Configure Cisco Unified MeetingPlace Express for the Calendar Integration

Step 1 Log on to Cisco Unified MeetingPlace Express and click Administration.

Step 2 Click User Configuration > User Profile Management.

Step 3 Click Add New.

Step 4 Enter the following values in the required fields to create an API user:

First Name Leave this field blank.

Last Name Enter Cisco Unity Connection.

User ID Enter cucsvc or another user ID that you want.
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Note The values that you enter for the User ID, User Password, and Profile Number fields will be used 
in the “Configuring Cisco Unity Connection for the Cisco Unified MeetingPlace Express 
Calendar Integration” section on page 35-27.

Step 5 Click Save.

Step 6 Log off of Cisco Unified MeetingPlace Express.

Caution If you do not log off of Cisco Unified MeetingPlace Express, the test will fail in the “To Test 
the Cisco Unified MeetingPlace Express Configuration for the Calendar Integration” 
procedure on page 35-27.

To Test the Cisco Unified MeetingPlace Express Configuration for the Calendar Integration

Step 1 In the Address field of a web browser, if SSL is not enabled, enter the following URL (where <server> 
is the IP address or host name of the Cisco Unified MeetingPlace Express server):

http://<server>.com/webservices/services/meetingservice?wsdl

If SSL is enabled, enter the following URL:

https://<server>.com/webservices/services/meetingservice?wsdl

Step 2 Press Enter.

Step 3 When prompted to log in, enter the user ID and password for the API user that you entered in the “To 
Configure Cisco Unified MeetingPlace Express for the Calendar Integration” procedure on page 35-26.

The Cisco Unified MeetingPlace Express WSDL download page appears with the title “XFire Services.”

Configuring Cisco Unity Connection for the Cisco Unified MeetingPlace 
Express Calendar Integration

Do the following procedure.

To Configure Cisco Unity Connection for the Cisco Unified MeetingPlace Express Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then click External Services.

Step 2 On the Search External Services page, click Add New.

Step 3 On the New External Service page, in the Type list, click MeetingPlace Express 2.0 External Service 
Template.

User Password Enter the applicable password.

Profile Number Enter the applicable profile number.

Type of User Click API User.
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Step 4 Check the Enabled check box.

When this check box is not checked, the calendar integration with Cisco Unified MeetingPlace Express 
is disabled.

Step 5 In the Display Name field, enter a descriptive name. For example, enter “Cisco Unified MeetingPlace 
Express calendar.”

Step 6 In the Server field, enter the IP address or host name for the Cisco Unified MeetingPlace Express server.

Step 7 In the Transfer Extension Dial String field, enter the digits that Connection must dial to transfer users 
on the phone to the opening greeting of Cisco Unified MeetingPlace Express server.

Step 8 In the Security Transport field, click the applicable setting:

• None—Connection does not use a secure connection with the Cisco Unified MeetingPlace Express 
server.

• SSL—Connection uses an SSL connection with the Cisco Unified MeetingPlace Express server.

Step 9 If you selected “SSL” and you want Connection to validate the Cisco Unified MeetingPlace Express 
server certificate, check the Validate Server Certificate check box.

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the CA that signed the server 
certificate must be installed as Connection-trust certificates in Cisco Unified Operating 
System Administration. Otherwise, validation of the server certificate will fail.

Step 10 In the Alias field, enter the Windows domain alias for the API user that Connection uses to log on to the 
Cisco Unified MeetingPlace Express server.

This setting must match the User ID setting for the API user that you configured in the “Configuring 
Cisco Unified MeetingPlace Express for the Calendar Integration” section on page 35-26.

Step 11 In the Password field, enter the password for the API user that Connection uses to log on to the Cisco 
Unified MeetingPlace Express server.

This setting must match the User Password setting for the API user that you configured in the 
“Configuring Cisco Unified MeetingPlace Express for the Calendar Integration” section on page 35-26.

Step 12 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that users can hear their upcoming meetings 
on the phone.

• MeetingPlace Scheduling and Joining—Check this check box so that users can schedule and join 
meetings.

Step 13 Click Save.

Step 14 To check the integration with Cisco Unified MeetingPlace Express, click Test. The Task Execution 
Results window appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace Express and 
Cisco Unity Connection.
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Configuring Users for the Cisco Unified MeetingPlace Express Calendar 
Integration

Do the following procedure.

Note Cisco Unified MeetingPlace Express must have an end user for each Connection user that you are 
configuring.

To Configure Users for the Cisco Unified MeetingPlace Express Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.

Step 2 On the Search Users page, click the alias of a user.

Step 3 On the Edit User Basics page, on the Edit menu, click External Service Accounts.

Step 4 On the External Service Accounts page, click Add New. The New External Service Accounts page 
appears.

Step 5 In the External Service field, click the display name that you entered in the “Configuring Cisco Unity 
Connection for the Cisco Unified MeetingPlace Express Calendar Integration” section on page 35-27.

Step 6 In the Login Type field, click the applicable option:

• Use Connection Alias—This option is useful when the Cisco Unified MeetingPlace Express profile 
alias is the same as the Connection user alias. Connection logs on the user with the Connection user 
alias. Cisco Unified MeetingPlace Express provides information on public and private meetings to 
the user.

• Use Server Guest Account—Connection logs on the user as a guest, without using the Connection 
user alias or the User ID setting. Cisco Unified MeetingPlace Express provides information only on 
public meetings to the user.

• Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace Express 
(useful when the Cisco Unified MeetingPlace Express profile alias is different from the Connection 
user alias). Connection logs on the user with the setting in this field. Cisco Unified MeetingPlace 
Express provides information on public and private meetings to the user.

Step 7 (Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the 
User ID setting from Cisco Unified MeetingPlace Express.

Step 8 (Only if enabled) In the User Profile Number field, enter the User ID setting from Cisco Unified 
MeetingPlace Express. Connection logs on the user with the setting in this field.

Step 9 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that users can hear their upcoming meetings 
by phone.

Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

• MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and 
join meetings.
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• Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for 
two or more external services, check this check box so that Cisco Unified MeetingPlace Express 
meetings will be set up through this Cisco Unified MeetingPlace Express server. Uncheck this check 
box so that Cisco Unified MeetingPlace Express meetings will be set up through another server.

Step 10 Click Save.

Step 11 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace Express, Cisco Unity 
Connection, and the user.

Step 12 Repeat Step 2 through Step 11 for all remaining users.

Testing the Cisco Unified MeetingPlace Express Calendar Integration
Do the following procedure.

To Test the Cisco Unified MeetingPlace Express Calendar Integration

Step 1 Log in to Cisco Unified MeetingPlace Express as an end user.

Step 2 Click Schedule.

Step 3 Enter values in the required fields to schedule a new meeting for the current time, and invite a user who 
has an account on Cisco Unity Connection.

Step 4 Log on to the Connection mailbox of the user that you invited to the Cisco Unified MeetingPlace Express 
meeting in Step 3.

Step 5 If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list 
meetings.

Step 6 When you hear the system announce the Cisco Unified MeetingPlace Express meeting that you just 
scheduled, either say Join, or press the applicable keys on the phone keypad to join the meeting.

Changing the Cisco Unity Connection Configuration for the Cisco Unified 
MeetingPlace Express Calendar Integration

You can change the Cisco Unity Connection configuration after the calendar integration was created. Do 
the following procedure.

To Change the Cisco Unity Connection Configuration for the Cisco Unified MeetingPlace Express Calendar 
Integration

Step 1 In Cisco Unity Connection Administration, expand System Settings, then click External Services.

Step 2 On the Search External Services page, locate the external service that you created when you integrated 
Connection with Cisco Unified MeetingPlace Express.
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Step 3 Verify that MeetingPlace Express 2.x is listed in the Server Type column for the integration.

Step 4 Click the name of the external service that you created when you integrated Connection with Cisco 
Unified MeetingPlace Express.

Step 5 To enable the calendar integration, check the Enabled check box. To disable the calendar integration, 
uncheck the Enabled check box.

Step 6 In the Display Name field, enter a descriptive name.

Step 7 In the Server field, enter the IP address or the host name URL for the Cisco Unified MeetingPlace 
Express server.

Step 8 In the Transfer Extension Dial String field, enter the digits that Connection must dial to transfer users 
on the phone to the opening greeting of Cisco Unified MeetingPlace Express server.

Step 9 In the Security Transport field, click the applicable setting:

• None—Connection does not use a secure connection with the Cisco Unified MeetingPlace Express 
server.

• SSL—Connection uses an SSL connection with the Cisco Unified MeetingPlace Express server.

Step 10 If you selected “SSL” and you want Connection to validate the Cisco Unified MeetingPlace Express 
server certificate, check the Validate Server Certificate check box.

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of 
the server certificate must match the setting of Server field. Otherwise, validation of the server 
certificate will fail.

The root certificate or all certificates in a root certificate chain of the CA that signed the server 
certificate must be installed as Connection-trust certificates in Cisco Unified Operating 
System Administration. Otherwise, validation of the server certificate will fail.

Step 11 In the Alias field, enter the Windows domain alias for the API user that Connection uses to log on to the 
Cisco Unified MeetingPlace Express server.

This setting must match the User ID setting for the API user that you configured in the “Configuring 
Cisco Unified MeetingPlace Express for the Calendar Integration” section on page 35-26.

Step 12 In the Password field, enter the password for the API user that Connection uses to log on to the Cisco 
Unified MeetingPlace Express server.

This setting must match the User Password setting for the API user that is configured in the “Configuring 
Cisco Unified MeetingPlace Express for the Calendar Integration” section on page 35-26.

Step 13 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that the user hears their upcoming meetings.

• MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and 
join meetings.

• Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for 
two or more external services, check this check box so that Cisco Unified MeetingPlace Express 
meetings will be set up through this Cisco Unified MeetingPlace Express server. Uncheck this check 
box so that Cisco Unified MeetingPlace Express meetings will be set up through another server.

Step 14 Click Save.

Step 15 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.
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If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace Express, Cisco Unity 
Connection, and the user.

Changing the User Configuration for the Cisco Unified MeetingPlace Express 
Calendar Integration

You can change the user configuration after the calendar integration was created. Do the following 
procedure.

To Change the User Configuration for the Cisco Unified MeetingPlace Express Calendar Integration

Step 1 In Cisco Unity Connection Administration, expand Users, then click Users.

Step 2 On the Search Users page, click the alias of a user.

Step 3 On the Edit User Basics page, on the Edit menu, click External Service Accounts.

Step 4 On the External Service Accounts page, in the Display Name column, click the display name for the 
Cisco Unified MeetingPlace Express service.

Step 5 On the Edit External Service Account page, in the Login Type field, click the applicable option:

• Use Connection Alias—This option is useful when the Cisco Unified MeetingPlace Express profile 
alias is the same as the Connection user alias. Connection logs on the user with the Connection user 
alias. Cisco Unified MeetingPlace Express provides information on public and private meetings to 
the user.

• Use Server Guest Account—Connection logs on the user as a guest, without using the Connection 
user alias or the User ID setting. Cisco Unified MeetingPlace Express provides information only on 
public meetings to the user.

• Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace Express 
(useful when the Cisco Unified MeetingPlace Express profile alias is different from the Connection 
user alias). Connection logs on the user with the setting in this field. Cisco Unified MeetingPlace 
Express provides information on public and private meetings to the user.

Step 6 (Only when the Use User ID Provided Below option is selected in Step 5) In the User ID field, enter the 
User ID setting from Cisco Unified MeetingPlace Express.

Step 7 (Only if enabled) In the User Profile Number field, enter the User ID setting from Cisco Unified 
MeetingPlace Express. Connection logs on the user with the setting in this field.

Step 8 Under Service Capabilities, check the applicable check boxes:

• User Access to Calendar—Check this check box so that users can hear their upcoming meetings 
by phone.

Note A user can have only one external service that has the User Access to Calendar and Personal 
Contacts check box or the User Access to Calendar check box checked.

• MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and 
join meetings.
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• Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for 
two or more external services, check this check box so that Cisco Unified MeetingPlace Express 
meetings will be set up through this Cisco Unified MeetingPlace Express server. Uncheck this check 
box so that Cisco Unified MeetingPlace Express meetings will be set up through another server.

Step 9 Click Save.

Step 10 To check the calendar configuration for the user, click Test. The Task Execution Results window appears 
with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace Express, Cisco Unity 
Connection, and the user.
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